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introduction
Thank you for using Key Production to

manufacture your vinyl, CD or DVD. 

We will endeavor to make your product the best

possible, because we know that your release is

important to you, and so it’s important to us too. 

We have made this guide to help you prepare

your artwork, please read through it, even if you

are an experienced graphic designer. ESSENTIAL INFORMATION.............................................................................................................. page 3

BARCODES.......................................................................................................................................... page 4
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essential information 
We prefer to be supplied with native files such as

Quark, Photoshop, InDesign, or  Illustrator. 

We can accept artwork supplied as a PDF file,

but as we have learned from experience, there is

a vast variety of pitfalls in supplying artwork as

a PDF. 

All images must be at least 300dpi. 

Images with fine lines or small text should be 600dpi, and bitmaps should be 1200dpi.

Colours should be CMYK or greyscale.  

Remember to send us all of the fonts that you have used. 

If you are emailing or sending us artwork via ftp then please zip or stuff the fonts.  

Mark all relevant information such as page numbers or spot colours or special instructions

on the pasteboard or in an area outside the bleed.

Never mark centre holes on the label artwork.  

If you want holes on printed vinyl sleeves be sure to let us know but do not mark them. 

Do not leave key lines around the outer edge of artwork.

Make sure that your catalogue number is on the label and cover (back and spine).

For vinyl make sure that the A & B sides are clearly marked. 

If your release is to be sold in the USA then it is essential to have "Made in England" printed on paper

parts.

Remember to include publishing and copyright information.

We cannot be held responsible for proof reading or spelling errors.  

All artwork should be proof read, by you, before it is given to us. 

Please clearly name your files by catalogue number, especially if you are sending us the files via ftp or

email, so they are easy for us to locate.

Make a print out of your artwork on

your home printer. Assemble the

artwork to make a mock-up of how the

artwork will look when it is printed.

This will give you the chance to double

check your artwork before you send it

to us, and it is useful to us if you send us

the mock-up with your artwork disc. 

!
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1 234567 891231

minimum width = 32mm

minimum 
height = 10mm

Barcodes must be a minimum size and adhere to

acceptable colour combinations to be readable by

barcode scanners. 

The must be a clearing space of 3mm either side

of the edge of the barcode.

If you would like us to place a barcode on your

artwork then leave a box that is at least 32mm x

10mm on your artwork.

barcodes

3mm 3mm
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photoshop 
GETTING STARTED

The easiest way to make your template in

Photoshop is to open the PDF that has been

supplied to you in Photoshop. 

A dialogue box similar to this will appear:

Set Resolution to 600dpi. 

Set Mode to CMYK Color. 

Make a new layer to put your artwork on.

The TOTAL INK COVERAGE should be less

than 300%. 

This means the CMYK value of any colour used

should not add up to more than 300.  For example,

if an image is made up of 85% cyan, 85%

magenta, 90% yellow and 100% black, the total

ink coverage is 360 (85 + 85 + 90 + 100 = 360)

To check the Total Ink in Photoshop:  

Open the info palette (Windows > Info).

Click on the small arrow on the top right of the

palette and select Info Palette Options. 

Change the First Colour Readout to Total Ink, and

the Second Colour Readout to CMYK Colour.

Hold your cursor over

the darkest parts of the

image and check the

Total Ink Readout.

COLOURS

It is important to design your artwork in CMYK

rather than RGB. To print your design the images

need to be CMYK. 

When images are converted from RGB to CMYK

the colours often appear more dull. 

If the image uses spot colours (Pantones), a

varnish or has a cut out, mark this on a separate,

clearly marked layer.

Black can made up of just black ink (for a dull

black), or can contain some Cyan Magenta and

Yellow too. The default CMYK Photoshop black

has values of 63/52/51/100, this is a rich black.  

If you are using a lot of black in your design then

make sure that the blacks match. You can easily

do this by opening the CHANNELS pallette and

click through the channels. If you have blacks that

don’t match then you could end up with unwanted

boxes and lines on your artwork.  Unmatching

blacks are very difficult to spot on screen, so it is

important to check the channels.
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photoshop 
QUICK CHECKLIST

R Fonts included (if applicable). 

R Files are at least 300dpi - (600dpi if small text or fine lines are included).

R 3mm bleed included.

R Total ink limit less than 300%. 

R Colour mode is CMYK or greyscale. 

R Spot colours are indicated clearly.

R Booklet pages are set up as printers pages and are labeled.

When you have finished your design, you can

either send us your artwork as an unflattened PSD

file, or flatten the file and save as a tif (with no

compression). 

If you supply as a PSD file then please delete any

empty or hidden layers, and include any fonts that

you have used, (zip or stuff the fonts to avoid

them corrupting). 
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quark & indesign essential information
InDesign and Quark XPress templates have been

supplied for you to use to design your artwork. 

Please remember the following points: 

Images must be at least 300dpi (or 600dpi for

onbody artwork and images with fine lines or

text) and be either CMYK or greyscale. 

Colours must be CMYK or spot (Pantone) colours. 

Ink coverage must be less than 300%. (see page 5)

Bleed must be included. (see page 10)

Text size must be over 5pt.

TIP: If using InDesign, use the Preflight feature

(File>Preflight) to check the fonts and images. 

TIP: Use the Collect for Output feature in Quark

XPress, or Package feature in InDesign to ensure

all images & fonts are included. 

TIP: If you're using Quark XPress, make sure that

OPI (Open Prepress Interface) in the XTensions

Manager is turned off.

QUICK CHECKLIST

R All images used in the design are supplied.

R Image resolution is over 300dpi (or 600dpi if design features fine text or lines),  

bitmap images should be 1200dpi. 

R Images used are correct print colours (CMYK or greyscale). 

R Extra information is listed on the pasteboard  (ie page numbers, label sides, colours). 

R Bleed is included.

R Pagination is correct.

R Quark XPress files are Single Language documents, and where possible, free from extensions.

R Fonts are included.
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RELATIVE RESOLUTION 

Remember that if images are placed into a layout

program such as QuarkXPress or InDesign or

Illustrator at more than 100% then the relative

resolution will be lowered. For example, if an

image is 300dpi and then used at 200%, the

relative resolution is 150dpi. 

IMAGES SIZE AND RESOLUTION 

All images must be at least 300dpi. Images with

fine lines or text are recommended to be 600dpi.

If the images are lower resolution than

recommended then there is a danger that the

finished printed article may not be as good quality

as expected.

using images in quark & indesign
USING IMAGES IN INDESIGN

If you are using InDesign, use the Preflight  function

to check if the images you are using are high enough

resolution and are CMYK or greyscale.

File > Preflight > Links and Images

This example shows that the image is unsuitable

for print because it is an RGB JPEG, with a

resolution of 144dpi. 

USING IMAGES IN QUARK XPRESS

If you are using Quark XPress and are unsure

whether your images are the correct resolution and

colour mode, open the images in Photoshop. The

top bar of the image will give the colour mode. 

To convert an image to CMYK click on 

Image > Mode and select CMYK Color. 

To check your image size in Photoshop

Open Image > Image Size

Make sure this resolution reading is for

pixels/inch. Check the figure in Resolution.

When you change an image from RGB to CMYK

you may notice that the colours become less vibrant.
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illustrator
If you are designing your artwork in Illustrator,

open the PDF template supplied to you in

Illustrator and create a new layer to place your

design on. 

If you are placing images into your design then

make sure that the images are at least 300dpi. (see

page 8 for more information) 

Send us the fonts used in your design, or turn the

fonts to outline. To do this select all the type, go to

Type in the top menu, and select Create Outlines.

Make sure that all colours are CMYK or greyscale

or spot colours if required. 

QUICK CHECKLIST: 

R Include all fonts, or turn all text to

outlines. (select all type, go to Type in the 

top menu bar and select Create Outlines).

R Images should be CMYK (or greyscale) 

and at least 300dpi, (or 600dpi if it is for a

CD or DVD onbody label).

R Colours are clearly marked.

R Bleed is included.

R Booklet pages are in the correct order.
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bleed

extend image to the dotted line (bleed)

keep text 

within 

this area

(safe area)

this is where the finished print will be cropped to

Bleed is the area outside the trim line that will be

trimmed off at finished print.  It is usually 3mm,

but may be more, it will be indicated on the

template supplied to you. 

Safe area is 3mm inside the edges of the artwork.

You need to keep all text and important graphics

within this area.

The text should be placed at least

3mm away from the edges of the

artwork, otherwise there is a 

danger that it will get cropped. 

Images that come to the edge of

the page should have an extra

3mm added. This is called bleed.

This version is wrong. The text is

right up against the edge of the

page and it is likely that some text

will get cropped.

These images do not have bleed,

so there is a danger that there will

be a white space at the edge of the

page.

cor
rect

wro
ng

It is essential to include bleed on all of your

artwork except CD or DVD labels.

Extend images to the edge of the bleed area, and

keep text within the safe area. 

You may have been supplied a template to use for

your artwork.  Make sure that you include bleed

when laying your artwork out onto the template! 



11

  4       1

  2       3

  8       1

  2       7

  6       3

  4       5

 12      1

  2      11

 10      3

  4       9

  8       5

  6       7

putting the pages in order 

It is not always obvious to

us what the page order is!

Please help us by marking

the page numbers on the

pasteboard or outside the

crop marks, or supply us

with a print out of your

booklet, with page order

clearly indicated.

!

Booklet artwork should be supplied paginated as printers pairs as illustrated below: 

4 page book 8 page book 12 page book
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artwork for cd labels
COLOURS

CD onbody artwork can be set up as either full

colour (CMYK) or using spot (Pantone) colours. 

If you have a full colour design then it is

recommended that a white base is also used.

List the colours that you use at the edge of the

template. Indicate if you want a white base or not.

If the disc does not have a base colour then the

silver of the disc will show though where there is

white (or tones) on your artwork . The silver part

of the disc does not go right to the centre of the

disc, there is a ring around the centre which is

clear plastic. Be aware of this if you are planning

to have the silver of the disc as part of your design.

TEXT

Text must be bigger than 5pt. 

For the best results make any text on the onbody

artwork vector (ie add text in Quark or use an

illustrator eps). 

Text that is part of an image (ie done in

Photoshop) may not print as clear, and should

always be at least 600dpi.

full colour 

CMYK with white base

2 colour

with no white base

Designing for a CD or DVD onbody label is

different to designing for paper. The way that the

design is printed on to the disc means that some

designs work better than others. Look at some of

the CDs in your own collection and think about

what makes them good or not! 

Please use the template supplied to you, do not

change the size or layout of the template. The

templates are in Quark XPress, InDesign and as a

PDF which can be opened and used in Illustrator

or Photoshop.

Remember that there is a central hole, but do not

mark this on your artwork. CD label artwork does

not need bleed adding.

Include a catalogue number on your artwork

IMAGES

Use images that are 600dpi. If you are using a

design with a lot of fine lines then it is best to use

vector lines (illustrator eps) rather than bitmap

images (photoshop)

Sometimes definition is lost with subtle tonal

shades, so avoid using tints that are less than 15%

or over 85%. 

QUICK CHECKLIST

R Colours are clearly marked.

R Design is CMYK or spot colours (Pantone).

R Images used are 600dpi.

R Catalogue number is included on the design.

R Indicate if a white base is required.
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how to send us your artwork

BY POST

Burn your artwork onto a disc, remember to write

the catalogue number and/or the artist and title of

the release clearly on the disc.

It is helpful if you include a print-out of your

artwork, write any instructions that you think are

relevant, and a contact phone number and/or

email address.

Address the disc to the planner who sent you the

artwork templates at:

Key Production 
8 Jeffreys Place 
London NW1 9PP
UK

WEB-BASED

You can also use a web-based ftp program, such

as YouSendIt. 

http://www.yousendit.com

Please send the notification to the planner who

sent you the artwork templates.

Now you are ready to give us your artwork. There are a few ways that you can send your artwork to us: 

BY FTP

An FTP program is needed to upload files to the Key Production ftp site. 

If you are using a PC  then you can use Filezilla or Core FTP, (both are free to download).

http://www.coreftp.com

http://filezilla-project.org

If you are using a Mac then you can download Cyberduck (donation) or Fetch (free trial) from these links,

http://download.cnet.com/Cyberduck/3000-2160_4-10246246.html

http://fetchsoftworks.com

All of these programs come with instructions. 

Please inform the planner who sent you the templates when your artwork is uploaded.

The Key Production FTP information is: 

URL: ftp.keyproduction.co.uk
Username: Guest
Password: Key!2008

http://www.coreftp.com/
http://filezilla-project.org/
http://download.cnet.com/Cyberduck/3000-2160_4-10246246.html
http://fetchsoftworks.com/
http://www.yousendit.com/

